Epson® SureColor® P400 User's Guide


Contents

SureColor P400 User’s Guide ..................................................................................................................... 9

Product Basics .......................................................................................................................................... 10
  Control Panel Buttons and Lights ....................................................................................................... 10
  Product Parts Locations ..................................................................................................................... 11
    Product Parts - Front ..................................................................................................................... 11
    Product Parts - Inside .................................................................................................................... 12
    Product Parts - Back ...................................................................................................................... 13
  The Power Off Timer .......................................................................................................................... 13
  Changing the Power Off Timer Setting - Windows ......................................................................... 14
  Changing the Power Off Timer Setting - OS X ............................................................................... 15
  Epson Connect Solutions for Smartphones, Tablets, and More ......................................................... 15
    Using the Epson iPrint Mobile App ................................................................................................ 16

Wi-Fi or Wired Networking ........................................................................................................................ 17
  Wi-Fi Infrastructure Mode Setup ..................................................................................................... 17
  Wi-Fi Protected Setup (WPS) ........................................................................................................... 18
    Using WPS to Connect to a Network ............................................................................................. 18
  Printing a Network Status Sheet ....................................................................................................... 19
  Changing or Updating Network Connections .................................................................................. 19
    Accessing the Web Config Utility ................................................................................................ 19
    Changing a USB Connection to a Wi-Fi Connection .................................................................. 19
    Changing a Wi-Fi Connection to a Wired Network Connection .................................................. 20
    Connecting to a New Wi-Fi Router .............................................................................................. 20

Loading Media ........................................................................................................................................... 22
  Loading Paper in the Sheet Feeder .................................................................................................... 22
  Loading Fine Art Media .................................................................................................................... 24
  Loading Posterboard and Thick Media ............................................................................................. 28
  Loading Roll Paper ............................................................................................................................ 30
    Cutting and Removing Roll Paper ............................................................................................... 34
  Cut Sheet Media Loading Capacity ................................................................................................. 36
  Available Epson Papers ..................................................................................................................... 38
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Borderless Paper Type Compatibility</td>
<td>43</td>
</tr>
<tr>
<td>Paper or Media Type Settings - Product Software</td>
<td>44</td>
</tr>
<tr>
<td>Printing from a Computer</td>
<td>46</td>
</tr>
<tr>
<td>Printing with Windows</td>
<td>46</td>
</tr>
<tr>
<td>Selecting Basic Print Settings - Windows</td>
<td>46</td>
</tr>
<tr>
<td>Print Quality Options - Windows</td>
<td>49</td>
</tr>
<tr>
<td>Color Management Options - Windows</td>
<td>49</td>
</tr>
<tr>
<td>Advanced Color Controls - Windows</td>
<td>51</td>
</tr>
<tr>
<td>Paper Source Options - Windows</td>
<td>51</td>
</tr>
<tr>
<td>Using Layout Manager - Windows Only</td>
<td>53</td>
</tr>
<tr>
<td>Selecting Print Layout Options - Windows</td>
<td>59</td>
</tr>
<tr>
<td>Reduce/Enlarge Options - Windows</td>
<td>60</td>
</tr>
<tr>
<td>Multi-Page Printing Options - Windows</td>
<td>60</td>
</tr>
<tr>
<td>Double-sided Printing Options - Windows</td>
<td>61</td>
</tr>
<tr>
<td>Selecting Additional Settings - Windows</td>
<td>61</td>
</tr>
<tr>
<td>Printing Your Document or Photo - Windows</td>
<td>63</td>
</tr>
<tr>
<td>Checking Print Status - Windows</td>
<td>65</td>
</tr>
<tr>
<td>Saving, Sharing, and Customizing the Printer Settings</td>
<td>65</td>
</tr>
<tr>
<td>Saving and Sharing Print Settings - Windows</td>
<td>66</td>
</tr>
<tr>
<td>Saving and Sharing Media Settings - Windows</td>
<td>67</td>
</tr>
<tr>
<td>Editing Print Setting Displays - Windows</td>
<td>68</td>
</tr>
<tr>
<td>Selecting Default Print Settings - Windows</td>
<td>70</td>
</tr>
<tr>
<td>Changing the Language of the Printer Software Screens</td>
<td>72</td>
</tr>
<tr>
<td>Changing Automatic Update Options</td>
<td>73</td>
</tr>
<tr>
<td>Printing with OS X</td>
<td>74</td>
</tr>
<tr>
<td>Selecting Basic Print Settings - OS X</td>
<td>74</td>
</tr>
<tr>
<td>Advanced Color Settings - OS X</td>
<td>78</td>
</tr>
<tr>
<td>Output Resolution Settings - OS X</td>
<td>80</td>
</tr>
<tr>
<td>Print Options - OS X</td>
<td>80</td>
</tr>
<tr>
<td>Selecting Roll Paper Settings - OS X</td>
<td>80</td>
</tr>
<tr>
<td>Selecting Print Layout Options - OS X</td>
<td>82</td>
</tr>
<tr>
<td>Managing Color - OS X</td>
<td>82</td>
</tr>
<tr>
<td>Color Matching Options - OS X</td>
<td>83</td>
</tr>
</tbody>
</table>
Cleaning and Transporting Your Product ................................................................. 119
  Cleaning Your Product ................................................................................................. 119
  Transporting Your Product ............................................................................................ 119

Solving Problems .............................................................................................................. 122
  Checking for Software Updates .................................................................................... 122
  Product Light Status ..................................................................................................... 123
  Running a Product Check ............................................................................................. 126
  Solving Setup Problems ............................................................................................... 126
    Noise After Ink Installation ....................................................................................... 127
    Software Installation Problems .................................................................................. 127
  Solving Network Problems .......................................................................................... 128
    Product Cannot Connect to a Wireless Router or Access Point ............................... 128
    Network Software Cannot Find Product on a Network ............................................. 129
    Product Does Not Appear in OS X Printer Window .................................................. 130
    Cannot Print Over a Network .................................................................................... 130
  Solving Paper Problems ............................................................................................... 131
    Paper Feeding Problems ......................................................................................... 132
    Paper Jam Problems - Sheet Feeder ....................................................................... 133
    Paper Jam Problems - Rear Manual Feed Tray ...................................................... 136
    Paper Jam Problems - Thick Media or CD/DVD ...................................................... 137
    Paper Jam Problems - Roll Paper ............................................................................. 137
    Paper Ejection Problems ........................................................................................... 138
  Solving Problems Printing from a Computer ............................................................... 139
    Nothing Prints ......................................................................................................... 139
    Noise Occurs, But Nothing Prints ............................................................................ 140
    Product Icon Does Not Appear in Windows Taskbar .............................................. 141
    Error After Cartridge Replacement .......................................................................... 141
    Printing is Slow ......................................................................................................... 142
  Solving Page Layout and Content Problems ............................................................... 143
    Inverted Image .......................................................................................................... 143
    Too Many Copies Print ............................................................................................. 143
    Blank Pages Print ..................................................................................................... 144
    Incorrect Margins on Printout .................................................................................... 144
Welcome to the SureColor P400 User's Guide.

For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.

Control Panel Buttons and Lights
Product Parts Locations
The Power Off Timer
Epson Connect Solutions for Smartphones, Tablets, and More

Control Panel Buttons and Lights

1. The power button
2. The Wi-Fi button
3. The network status button
4. The paper/cancel button
5. The ink button
6. The roll paper button
7. The ink light
8. The paper/cancel light
9. The power light
10. The network light
Parent topic: Product Basics

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics

Product Parts - Front

1 Printer cover
2 Output tray and extensions
3 Front manual feed tray
4 Control panel
5 Automatic sheet feeder
6 Edge guide
7 Paper support and extensions

Parent topic: Product Parts Locations

Product Parts - Inside

1 Ink absorber
2 Ink check lights
3 Cartridge cover
4 Print head

Parent topic: Product Parts Locations
The Power Off Timer

The product turns off automatically if it is not used for a period of time after it enters sleep mode. You can adjust the time period before power off, but increasing the time reduces the product's energy efficiency.

Changing the Power Off Timer Setting - Windows
Changing the Power Off Timer Setting - Windows

You can use the printer software to change the time period before the printer turns off automatically.

1. Access the Windows Desktop, right-click the product icon in the Windows taskbar, and select **Printer Settings**.
2. Click the **Utility** tab and select **Printer and Option Information**.
   
   You see this window:

   ![Printer and Option Information](image)

   3. In the drop-down menu, select the length of time after which you want the product to automatically turn off when it is not in use.
   4. Click **Send**.
   5. When you see the time you selected listed as the Current Printer Setting, click **OK**.

Parent topic: The Power Off Timer
Changing the Power Off Timer Setting - OS X

You can use the printer software to change the time period before the printer turns off automatically.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

2. Select Printer Settings.

You see this window:

3. Select the length of time after which you want the product to automatically turn off when it is not in use as the Power Off Timer setting.

4. Click Apply.

5. Close the Printer Settings window.

Parent topic: The Power Off Timer

Epson Connect Solutions for Smartphones, Tablets, and More

You can use your smartphone, tablet, or computer to print documents, photos, emails, and web pages from your home or office.

Using the Epson iPrint Mobile App
Using the Epson iPrint Mobile App

Use this free Apple and Android app to print to nearby Epson networked products.

1. Set up your product on a network. See the link below.
2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.
- Wi-Fi Infrastructure Mode Setup
- Wi-Fi Protected Setup (WPS)
- Printing a Network Status Sheet
- Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1 Epson product
2 Wireless router or access point
3 Computer with a wireless interface
Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

**Note:** To check if your router is WPS-enabled, look for a button labeled **WPS** on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

**Using WPS to Connect to a Network**

If you have a WPS-enabled router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your device to the network.

**Note:** To check if your router is WPS-enabled, look for a button labeled **WPS** on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

1. To connect to a WPS-enabled router, press the **WPS** button on your router or access point.
2. Press and hold down the **Wi-Fi** button on your product for 3 seconds.
   The left side of the network light turns blue to indicate a successful connection.

**Note:** Be sure to press and hold the **Wi-Fi** button on your product within 2 minutes of pressing the **WPS** button on your router or access point.
Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.

To print the status sheet, press the network status button on the product. Examine the settings shown on the network status sheet to diagnose any problems you have.

Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections

See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product’s network settings and confirm its operating status using a web browser.

You do this by accessing your product’s built-in Web Config utility from a computer or other device that is connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar.
   
   You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections

Related tasks

Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection.
1. Disconnect the USB cable from your product.
2. Uninstall your product software.
3. Download and install your product software from the Epson website using the instructions on the Start Here sheet.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**
- Uninstalling Printing Software - Windows
- Uninstalling Product Software - OS X

### Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.

1. Connect one end of an Ethernet network cable to the product's LAN port.
2. Connect the other end to any available LAN port on your router or access point.
3. Uninstall your product software.
4. Download and install your product software from the Epson website.
5. Follow the on-screen instructions to install the software.
6. When you see the Select Your Connection screen, select **Wired network connection**.
7. If you see a Select Setup Option screen, select **Set up printer for the first time**.
8. Continue following the rest of the on-screen instructions.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**
- Uninstalling Printing Software - Windows
- Uninstalling Product Software - OS X

### Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your product's Wi-Fi connection to the new router.

**Note:** If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.
1. Do one of the following:
   - **Windows**: Uninstall your product software.
   - **OS X**: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the *Start Here* sheet.

**Parent topic:** Changing or Updating Network Connections

**Related tasks**

Uninstalling Printing Software - Windows
Loading Media

Before you print, load media for the type of printing you will do.

Loading Paper in the Sheet Feeder
Loading Fine Art Media
Loading Posterboard and Thick Media
Loading Roll Paper
Cut Sheet Media Loading Capacity
Available Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings - Product Software

Loading Paper in the Sheet Feeder

You can load a variety of paper types and sizes in the sheet feeder.

1. Turn on your product.
2. Open the paper support and pull up the extensions.
3. Open the front cover.

4. Extend the output tray.

5. Insert paper, glossy or printable side up, short edge first, against the right edge and behind the tab.
6. Press the button on the edge guide and slide it to the edge of the paper.

Always follow these paper loading guidelines:
• Load only the recommended number of sheets.
• Load paper short edge first, no matter which way your document faces.
• Load the printable side faceup.
• Load letterhead or pre-printed paper top edge first.
• Do not load paper above the arrow mark inside the edge guide.
• Check the paper package for any additional loading instructions.

Related references
Cut Sheet Media Loading Capacity
Loading Fine Art Media
Loading Posterboard and Thick Media

Loading Fine Art Media
Use the rear manual feed guide to load fine art media.

Note: You can load fine art media with a thickness of 0.012 to 0.028 inch (0.3 to 0.7 mm).
1. Turn on your product.
2. Remove any paper from the sheet feeder and close the paper support.
3. Remove any roll paper and the roll paper holders.
4. Slide the rear roll paper edge guide all the way to the right.
5. Align the arrows on the rear manual feed guide with the arrows on the back of the product and hook the feed guide on the rail.

6. Open the front cover.
7. Open the output tray.

8. Insert a single sheet of fine art paper into the rear manual feed guide, short edge first and printable side up. Slide the edge guide to the edge of the paper.

9. Feed the paper until it stops and hold it there for about three seconds. The product feeds the paper automatically.

Always follow these paper loading guidelines:

• Load only one sheet at a time.
• Load fine art media short edge first, no matter which way your document faces.
• Load the printable side face up.
• Check the paper package for any additional loading instructions.
Note: If you need to eject the paper from the rear of the printer without printing, press the \(\text{roll paper} \) button for three seconds. Remove the paper and press the \(\text{roll paper} \) button again to clear the flashing \(\text{paper/cancel} \) light.

Parent topic: Loading Media

Related references
Cut Sheet Media Loading Capacity
Available Epson Papers

Related tasks
Loading Roll Paper
Loading Paper in the Sheet Feeder
Loading Posterboard and Thick Media

Loading Posterboard and Thick Media

Use the front manual feed tray to load media with a thickness of 0.028 to 0.051 inch (0.7 to 1.3 mm).

Caution: Do not open the front manual feed tray or load thick paper while the product is operating. This may damage your product.

Note: Be sure to leave at least 13 inches (32 cm) of space behind your product for the media to feed through.

1. Turn on your product.
2. Remove any paper from the sheet feeder and close the paper support.
3. Remove any roll paper and the roll paper holders.
4. Open the front cover.
5. Open the front manual feed tray.

![Diagram](image1)

6. Slide the edge guide all the way to the left.

![Diagram](image2)

7. Insert a single sheet of posterboard or thick media into the manual feed tray, short edge first and printable side up.

![Diagram](image3)

**Caution:** Never load media from the rear or you could damage your product.
8. Feed the paper up to the triangles near the end of the tray. Make sure the paper is flush against the right side and slide the edge guide to the edge of the paper.

Parent topic: Loading Media
Related references
Cut Sheet Media Loading Capacity
Related tasks
Loading Fine Art Media
Loading Paper in the Sheet Feeder

Loading Roll Paper

You can load 13-inch (329 mm, A3+) wide roll paper for printing large or panoramic images, or multiple photos (with or without borders).

Note: It’s a good idea to check the ink status and replace cartridges, if necessary, before printing a large print job. If you need to replace a cartridge during printing, you can continue to print but you might notice a color difference in your printout depending on drying conditions.

1. Turn on your product.
2. Remove any paper from the sheet feeder and close the paper support.
3. Remove the rear manual feed guide, if installed.
4. Open the front cover.

5. Remove any tape and protective paper from the end of the paper roll. Make sure the paper is cut straight across to avoid paper feeding problems.

   **Note:** Avoid touching the surface of your paper. With canvas media that you have previously loaded, cut the edge straight each time you reload it for best results.

6. Place the roll paper holders on each end of the paper roll as shown.

7. Move the roll paper edge guide all the way to the right.
8. Attach the roll paper holders as shown. Hook the holders onto the attachment points marked with orange arrows.

*Note:* Make sure the roll paper is oriented so that the paper is fed over the top of the roll as shown.
9. Feed the paper into the roll paper feeder (marked with the icon shown) until it meets resistance. Move the roll paper edge guide to the edge of the paper. In a few seconds, the paper loads automatically.

10. Open the printer cover and make sure that the paper is aligned correctly. If the edge feeds at an angle, remove the roll paper and load it again. Make sure the edge is cut at a $90^\circ$ angle.

Cutting and Removing Roll Paper

Parent topic: Loading Media
Cutting and Removing Roll Paper

After printing on roll paper, use scissors as described here to cut the roll paper from your printout.

1. When printing is complete, press the roll paper button.

The printer prints a cut line and feeds the roll paper.
Note: If the roll paper runs out during printing, the paper does not eject automatically. Hold the roll paper and press the "Paper/Cancel" button.

2. Use scissors to cut the paper along the cut line.

3. Do one of the following:
   - To continue printing on roll paper, press the "Roll Paper" button to move the roll paper into printing position.
• To remove the roll paper, press and hold the roll paper button for three seconds. The roll paper ejects from the back of the product. Turn the knobs on the roll paper holders backward as the paper unloads, then remove the paper and holders from your product.

4. Press the roll paper button to clear the paper out error.

Parent topic: Loading Roll Paper

Cut Sheet Media Loading Capacity
You can load cut sheet media in the paper types and quantities listed here into your product.

Sheet Feeder

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Loading capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>120 sheets</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>100 sheets Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td></td>
<td>50 sheets 13 × 19 inches (330 × 483 mm)</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>80 sheets</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>30 sheets</td>
</tr>
<tr>
<td>Paper type</td>
<td>Loading capacity</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>30 sheets 4 × 6 inches (102 × 152 mm), 8 × 10 inches (203 × 254 mm), Letter (8.5 × 11 inches [216 × 279 mm]), 11 × 14 inches (279 × 356 mm)</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>20 sheets 5 × 7 inches (127 × 178 mm)</td>
</tr>
<tr>
<td></td>
<td>10 sheets A3 (11.7 × 16.5 inches [297 × 420 mm]), B4 (13.9 × 9.84 inches [353 × 250 mm]), 13 × 19 inches (330 × 483 mm)</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>30 sheets Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>10 sheets A3 (11.7 × 16.5 inches [297 × 420 mm]), 13 × 19 inches (330 × 483 mm)</td>
</tr>
<tr>
<td>Epson Metallic Photo Paper Glossy</td>
<td>30 sheets Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td>Epson Metallic Photo Paper Luster</td>
<td>10 sheets A3 (11.7 × 16.5 inches [297 × 420 mm]), 13 × 19 inches (330 × 483 mm)</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>30 sheets 4 × 6 inches (102 × 152 mm), Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td></td>
<td>10 sheets B4 (13.9 × 9.84 inches [353 × 250 mm])</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>30 sheets 8 × 10 inches (203 × 254 mm), Letter (8.5 × 11 inches [216 × 279 mm])</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>10 sheets 11 × 14 inches (279 × 356 mm), A3 (11.7 × 16.5 inches [297 × 420 mm]), 13 × 19 inches (330 × 483 mm)</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>1 sheet</td>
</tr>
</tbody>
</table>

**Manual Feed Tray**

You can load one sheet of posterboard or other thick media 0.028 to 0.051 inch (0.7 to 1.3 mm) thick in this size in the front manual feed tray: 13 × 19 inches (330 × 483 mm). You can also load one sheet of the following types of media:

- Epson Velvet Fine Art Paper
- Epson UltraSmooth Fine Art Paper
Available Epson Papers

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Cold Press Bright</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042307</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S042310</td>
<td>25</td>
</tr>
<tr>
<td>Epson Cold Press Natural</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042297</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S042300</td>
<td>25</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Velvet Fine Art Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041636</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041637</td>
<td>20</td>
</tr>
<tr>
<td>Epson Hot Press Bright</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042327</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S042330</td>
<td>25</td>
</tr>
<tr>
<td>Epson Hot Press Natural</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042317</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S042320</td>
<td>25</td>
</tr>
<tr>
<td>Epson Exhibition Watercolor Paper Textured</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S045486</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S045487</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042175</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td>Epson Premium Luster Photo Paper (260)</td>
<td>13 inches (330 mm) × 32 feet (9.8 m)</td>
<td>S041409</td>
<td>1 roll</td>
</tr>
<tr>
<td></td>
<td>10 inches (254 mm) × 100 feet (30.5 m)</td>
<td>S042077</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Metallic Photo Paper Glossy</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S045589</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S045590</td>
<td>25</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Epson Metallic Photo Paper Luster</strong></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S045516</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches</td>
<td>S045517</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>(330 × 483 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Epson Photo Paper Glossy</strong></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches</td>
<td>S041156</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>(279 × 432 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches</td>
<td>S041143</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>(330 × 483 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper Glossy</strong></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041286</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041288</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches</td>
<td>S041289</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>(330 × 483 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041667</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches</td>
<td>S041290</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>(279 × 432 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches</td>
<td>S041466</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>(279 × 356 mm)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td>Semi-gloss</td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041327</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches (279 × 356 mm)</td>
<td>S041468</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches (297 × 420 mm)</td>
<td>S041260</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041263</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Presentation Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041568</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Paper Matte Double-sided</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td>Paper Matte</td>
<td>Legal (8.5 × 14 inches [216 × 356 mm])</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches (279 × 432 mm)</td>
<td>S041070</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041069</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>16.5 × 23.4 inches (420 × 594 mm)</td>
<td>S041079</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>17 × 22 inches (432 × 559 mm)</td>
<td>S041171</td>
<td>100</td>
</tr>
<tr>
<td>Epson Signature Worthy Sample</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S045234</td>
<td>14</td>
</tr>
<tr>
<td>Pack</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper</td>
<td>Letter (8.5 × 11 inches</td>
<td>S041405</td>
<td>50</td>
</tr>
<tr>
<td>Luster</td>
<td>[216 × 279 mm])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches</td>
<td>S041406</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>[297 × 420 mm])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041407</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041604</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>17 × 22 inches (432 × 559 mm)</td>
<td>S042084</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>13 inches (330 mm) × 32.8 feet (10 m)</td>
<td>S041409</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation</td>
<td>Letter (8.5 × 11 inches</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td>Paper Matte</td>
<td>[216 × 279 mm])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches</td>
<td>S041343</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>[297 × 420 mm])</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S04139</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041605</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>17 × 22 inches (432 × 559 mm)</td>
<td>S041908</td>
<td>100</td>
</tr>
<tr>
<td>Epson UltraSmooth Fine Art Paper</td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041896</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>17 × 22 inches (432 × 559 mm)</td>
<td>S041897</td>
<td>25</td>
</tr>
<tr>
<td>Epson Watercolor Paper Radiant</td>
<td>13 × 19 inches (330 × 483 mm)</td>
<td>S041351</td>
<td>20</td>
</tr>
<tr>
<td>White</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Exhibition Canvas Matte</td>
<td>13 inches (330 mm) × 20 feet (6.1 m)</td>
<td>S045255</td>
<td>1 roll</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Natural Matte</td>
<td>13 inches (330 mm) × 20 feet (6.1 m)</td>
<td>S045396</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Gloss</td>
<td>13 inches (330 mm) × 20 feet (6.1 m)</td>
<td>S045241</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Natural Gloss</td>
<td>13 inches (330 mm) × 20 feet (6.1 m)</td>
<td>S045410</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Satin</td>
<td>13 inches (330 mm) × 20 feet (6.1 m)</td>
<td>S045248</td>
<td>1 roll</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Natural Satin</td>
<td>13 inches (330 mm) × 20 feet (6.1 m)</td>
<td>S045403</td>
<td>1 roll</td>
</tr>
</tbody>
</table>

**Parent topic:** Loading Media

**Borderless Paper Type Compatibility**

You can print borderless photos on compatible paper types in compatible sizes.

**Borderless Paper Types**

- Epson Brochure & Flyer Paper Matte Double-sided
- Epson Ultra Premium Presentation Paper Matte
- Epson Premium Presentation Paper Matte
- Epson Premium Presentation Paper Matte Double-sided
- Epson Ultra Premium Photo Paper Glossy
- Epson Premium Photo Paper Semi-gloss
- Epson Ultra Premium Photo Paper Luster
- Epson Velvet Fine Art Paper
- Epson Watercolor Paper Radiant White
- Epson UltraSmooth Fine Art Paper 325 gsm
- Epson Premium Photo Paper Glossy
- Epson Photo Paper Glossy
Borderless Paper Sizes

- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- Letter (8.5 × 11 inches [216 × 279 mm])
- 11 × 14 inches (279 × 356 mm)
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A3 (11.7 × 16.5 inches [297 × 420 mm])
- 13 × 19 inches (330 × 483 mm)

Parent topic: Loading Media

### Paper or Media Type Settings - Product Software

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this Paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semigloss</td>
</tr>
<tr>
<td>Premium Luster Photo Paper (260)</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Ultra Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>For this paper</td>
<td>Select this Paper Type or Media Type setting</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Epson Velvet Fine Art Paper</td>
<td>Velvet Fine Art Paper</td>
</tr>
<tr>
<td>Epson Metallic Photo Paper Glossy</td>
<td>Metallic Photo Glossy</td>
</tr>
<tr>
<td>Epson Metallic Photo Paper Luster</td>
<td>Metallic Photo Luster</td>
</tr>
<tr>
<td>Epson Hot Press Bright</td>
<td>Hot Press Bright</td>
</tr>
<tr>
<td>Epson Hot Press Natural</td>
<td>Hot Press Natural</td>
</tr>
<tr>
<td>Epson Cold Press Bright</td>
<td>Cold Press Bright</td>
</tr>
<tr>
<td>Epson Cold Press Natural</td>
<td>Cold Press Natural</td>
</tr>
<tr>
<td>Epson Exhibition Watercolor Paper Textured</td>
<td>Exhibition Watercolor Textured</td>
</tr>
<tr>
<td>Epson Watercolor Paper Radiant White</td>
<td>Watercolor Paper - Radiant White</td>
</tr>
<tr>
<td>Epson UltraSmooth Fine Art Paper</td>
<td>UltraSmooth Fine Art Paper</td>
</tr>
<tr>
<td>Epson UltraSmooth Fine Art Paper 325 gsm</td>
<td>UltraSmooth Fine Art Paper</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Matte</td>
<td>Exhibition Canvas Matte</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Natural Matte</td>
<td>Exhibition Canvas Natural Matte</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Gloss</td>
<td>Exhibition Canvas Gloss</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Natural Gloss</td>
<td>Exhibition Canvas Natural Gloss</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Satin</td>
<td>Exhibition Canvas Satin</td>
</tr>
<tr>
<td>Epson Exhibition Canvas Natural Satin</td>
<td>Exhibition Canvas Natural Satin</td>
</tr>
<tr>
<td>Ink jet printable CD or DVD</td>
<td>CD/DVD or CD/DVD Premium Surface (front manual feed tray only)</td>
</tr>
</tbody>
</table>
Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

**Note:** If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select **Enable automatic checking** and click **OK**. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

Printing with Windows
Printing with OS X
Managing Colors with Profiles

Printing with Windows

You can print with your product using any Windows application, as described in these sections.

Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Printing Your Document or Photo - Windows
Saving, Sharing, and Customizing the Printer Settings
Selecting Default Print Settings - Windows
Changing the Language of the Printer Software Screens
Changing Automatic Update Options

**Parent topic:** Printing from a Computer

Selecting Basic Print Settings - Windows

Select the basic settings for the photo or document you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

**Note:** You may need to select a print icon on your screen, the **Print** option in the File menu, or another command. See your application's help utility for details.
3. If necessary, select your product name as the printer you want to use.

**Note:** You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

![Printer settings window](image)

4. Select the **Media Type** setting that matches the paper you loaded.

5. If you are using non-Epson paper or media and you need to fine-tune its performance, click the **Custom Settings** button and adjust paper configuration options as necessary.
6. Select a **Color** option:
   - To print a color document or photo, select the **Color** setting.
   - To print text and graphics in black or shades of gray, select the **Grayscale** setting.

   **Note:** The **Grayscale** setting is available only when plain paper is selected as the **Media Type**.

7. For the **Print Quality** setting, select **Speed** or **Quality**, or select **Quality Options** and choose the quality option that matches the print quality you want to use.

8. Select the desired color management option as the **Mode** setting.

9. Select the **Source** setting that matches the paper feeding method you are using.

10. Select the size of the paper you loaded as the **Size** setting.

   **Note:** You can also select the **User-Defined** setting to create a custom paper size.

11. If you want to print a photo without borders, select **Borderless**.

   **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

12. To see a preview of how your document or photo will print, select **Print Preview**. (The preview appears after you click **Print** but before printing starts.)

13. To layout multiple print jobs for printing all at once, select **Layout Manager**.

---

**Print Quality Options - Windows**
**Color Management Options - Windows**
**Advanced Color Controls - Windows**
**Paper Source Options - Windows**
**Using Layout Manager - Windows Only**

**Parent topic:** Printing with Windows

**Related references**
**Double-sided Printing Options - Windows**

**Related tasks**
**Printing Your Document or Photo - Windows**
Print Quality Options - Windows

You can use the Speed/Quality slider to set the desired quality level, and select any of the available Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

High Speed
- Speeds up printing but may reduce print quality.

Edge Smoothing
- Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Finest Detail
- Sharpens edges on vector-based data including text, graphics, and line art. (This setting does not affect photographs.)

Gloss Optimizer
- Adds a glossy finish to your print.

Parent topic: Selecting Basic Print Settings - Windows

Color Management Options - Windows

You can adjust the Mode setting to fine-tune the colors in your printout, or turn off color management in your printer software.

EPSON Standard (sRGB)
- Increases the contrast in images. Click the Advanced button to use advanced color controls.

Adobe RGB
- Matches image colors to the Adobe RGB color standard. Use this setting if your source file was captured in Adobe RGB. Click the Advanced button to use advanced color controls.

EPSON Vivid
- Processes colors to create standard hues. Click the Advanced button to use advanced color controls.

PhotoEnhance
- Lets you choose from various Scene Correction settings to automatically analyze your photos.

Note: PhotoEnhance uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off PhotoEnhance to retain the special color effects.
ICM
Automatically adjusts colors based on the printer’s ICC profile and the selected Media Type setting, using the Image Color Matching system. Click the Advanced button to choose the input profile and other settings.

Note: In most cases, you get better results by applying color management in your application, rather than in the printer driver.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your application software.

Note: An ICC profile is required if color management is turned off.

Parent topic: Selecting Basic Print Settings - Windows
Advanced Color Controls - Windows

If you selected EPSON Standard (RGB), Adobe RGB, or EPSON Vivid as the Mode setting, you can click the Advanced button to select detailed settings.

The Color Controls screen lets you specify values for adjusting brightness, contrast, saturation, and individual Cyan, Magenta, and Yellow color tones. You can choose from three Printer Color Adjustment modes and two Gamma settings, and use either a color circle or slide bar to adjust color.

Parent topic: Selecting Basic Print Settings - Windows

Paper Source Options - Windows

You can select any of the available options in the paper Source menu to print on the paper loaded in that source.

Sheet
  Selects sheets of paper loaded in the sheet feeder.
Roll Paper
Selects roll paper loaded in the roll paper holder for photos or panoramics up to 27 inches (68.6 cm) long. Click **Print page frame** to print a cutting guideline around each photo.

Roll Paper (Banner)
Selects roll paper loaded in the roll paper holder for photos or banners over 27 inches (68.6 cm) long.

Rear - Fine Art
Selects fine art paper loaded in the rear manual feed tray.

Front - Poster Board
Selects poster board or other thick media loaded in the front manual feed tray.

CD/DVD
Selects the CD or DVD loaded as the source.

**Parent topic:** Selecting Basic Print Settings - Windows
Using Layout Manager - Windows Only

Layout Manager lets you create a poster or display by dragging multiple pieces of print data created in different applications onto one sheet of paper for printing.
You can also place the same print data multiple times as shown here.
You can place print data in different sizes and orientations to maximize media usage, as shown here.
You can place print data on roll paper as shown here.

1. Open the file you want to print in your application.
2. Select the print command in your application.
3. Select **Layout Manager** on the Main tab and choose an option for the **Size** setting that matches the size of the document in the application.

![Layout Manager Screen]

**Note:** You select the size of the paper you are printing on in a later step.

4. Click **OK** and then click **Print**, if necessary.

   The Layout Manager screen opens and displays one page in the layout.

5. Leave the Layout Manager screen open and repeat steps 1 to 4 to arrange additional print data. The pages are added to the Layout Manager screen.
6. Do the following to arrange objects on the Layout Manager screen:
   • Drag pages to move and resize them.
   • Use the tool buttons and the Object menu to align and rotate pages.
   • Resize and replace whole pages in the Preference or Arrangement Settings screens.

   **Note:** See the Layout Manager screen help for more details.

7. Click **File > Properties**, then select your print settings on the Main tab.
8. Click the **File** menu on the Layout Manager screen and click **Print**.

   **Note:** To save the current job to a file, click the **File** menu on the Layout Manager screen, save the file, and close the Layout Manager screen. To open the saved file later for editing or reprinting, right-click the printer icon in the Windows taskbar, select **Layout Manager**, and open the file.

**Parent topic:** Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows

You can select a variety of sizing and layout options for your document or photo on the Page Layout tab.

- To change the orientation of your printed document or photo, select the Portrait or Landscape checkbox.
- To rotate or flip the printed image, select the Rotate 180° or Mirror Image checkbox.
- To select multiple copies and their print order, select the Copies, Collate, and Reverse Order options.
• To change the size of your printed document or photo, select the **Reduce/Enlarge** checkbox and select sizing options.

• To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select the **Multi-Page** checkbox and select the options you want.

• To print on both sides of your paper, select the **Double-Sided Printing** options.

  **Note:** Your product software prompts you to reinsert your paper when it is time to print on the reverse side.

• To enlarge your image beyond the limits of your application program, select **Optimize Enlargement**.

  **Note:** The driver can increase the image size up to 650% and decrease the output resolution to stay within the pixel limitations. Depending on the resolution of the original image and the print size, you may see reduced print quality.

• To print a color background on the page, select **Print Bckg Color** and click **Color Settings** to select the color you want to use.

• To print the time, date, and other information about your print job at the top or bottom of the page, select **Job Settings** and click **Details** to select the settings you want to use.

**Reduce/Enlarge Options - Windows**

**Multi-Page Printing Options - Windows**

**Double-sided Printing Options - Windows**

**Parent topic:** Printing with Windows

**Reduce/Enlarge Options - Windows**

You can select any of the Reduce/Enlarge options to size your printed image.

**Fit to Page**

Sizes your printed image to fit on the paper you loaded and selected as the Output Paper setting.

**Fit to Roll Paper Width**

Sizes your printed image to fit the width of the roll paper you loaded.

**Custom**

Sizes your printed image by the percentage you select as the **Scale to** setting.

**Parent topic:** Selecting Print Layout Options - Windows

**Multi-Page Printing Options - Windows**

You can select these Multi-Page options to set up your multi-page print job.
N-up
Prints 2 (2-up) or 4 (4-up) pages on one sheet of paper.

Poster
Prints one image on multiple sheets of paper to create a large poster with or without borders. Click the Settings button to select the layout and guideline options.

Parent topic: Selecting Print Layout Options - Windows

Double-sided Printing Options - Windows
You can select any of the double-sided options to set up your double-sided print job.

Margins
Click Margins to customize the margins used during double-sided printing.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Folded Booklet Option
Select a binding option to use when creating a folded booklet.

Parent topic: Selecting Print Layout Options - Windows

Selecting Additional Settings - Windows
You can run maintenance utilities and select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Utility tab.
You see a window like this:

4. Select any of the following options, as necessary:
   - **Nozzle Check** to print a nozzle check pattern to check whether the print head nozzles are clogged.
   - **Head Cleaning** to clean the print head if you notice banding or gaps in your printouts.
   - **Print Head Alignment** to align the print head if printouts appear grainy or out of focus.
   - **Ink Density Optimization** to mix the ink automatically.
   - **Epson Status Monitor 3** to check the printer’s status.
• **Monitoring Preferences** to select the error notifications displayed on the Epson Status Monitor 3 screen, or add a shortcut to the utility in the Windows taskbar.

• **Print Queue** to display a list of all waiting print jobs, view information on the data waiting to be printed, and delete or reprint the jobs.

• **Printer and Option Information** to set the time to turn off the printer automatically.

• **Speed and Progress** to select various printing options.

• **Menu Arrangement** to arrange the **Setting**, **Media Type**, and **Paper Size** options by frequency of use.

• **Export or Import** to save the print settings to a file or import them from a file. This is useful when you want to select the same print settings on multiple computers.

• **Language** to select the language you want to use for the printer software screens.

• **Driver Update** to check the Epson website for any available printer software updates and install them automatically.

5. Click **OK** to close the printer software window.

**Parent topic:** Printing with Windows

**Related tasks**

[Printing Your Document or Photo - Windows](#)

**Printing Your Document or Photo - Windows**

Once you have selected your print settings, you are ready to save your settings and print.

1. Click **OK** to save your settings.
You see your application's Print window, such as this one:

2. Click **OK** or **Print** to start printing.

Checking Print Status - Windows

**Parent topic:** Printing with Windows
Checking Print Status - Windows

During printing, you see this window showing the progress of your print job. It allows you to control printing and check ink cartridge status.

- To cancel printing, click **Cancel**.
- To see print jobs waiting to print, click **Print Queue**.

**Parent topic:** Printing Your Document or Photo - Windows

Saving, Sharing, and Customizing the Printer Settings

You can save groups of print settings or media settings so you can reuse them for future print jobs. You can export these settings as a file so you can share them with other users. You can also edit the settings displayed in the printer software screens.

**Saving and Sharing Print Settings - Windows**
**Saving and Sharing Media Settings - Windows**
**Editing Print Setting Displays - Windows**

**Parent topic:** Printing with Windows
Saving and Sharing Print Settings - Windows

You can save your print settings so you can use them for future print jobs.

1. Select the print settings you want to save.

2. Click **Save/Del** at the top of the Main or Page Layout tab in your printer software.

   You see a window like this:

   ![Window for saving print settings](image)

3. Verify that your settings are correct, enter a name for the group of settings in the **Name** field, and click **Save**.

   **Note:** If you need to delete a group of settings you have created, select the name of the group of settings from the list and click **Delete**.

4. Do the following as necessary:
   - Select the name of the group of settings from the Select Setting list and use them to print.
   - To export the settings, click **Save/Del**, select the name of the group of settings, click **Export**, select a location, and enter a file name.
• To import a group of settings, click **Save/Del**, click **Import**, select the file you want to use, and click **Open**. Then use the settings to print.

**Parent topic:** Saving, Sharing, and Customizing the Printer Settings

**Saving and Sharing Media Settings - Windows**

You can save and share settings you have selected for a particular media type so you can use them for future print jobs.

1. Select the Media Settings you want to save on the Main tab, as necessary.
2. Click **Custom Settings**.

   You see a window like this:

   ![Custom Settings Window](image)

3. Verify that your settings are correct, enter a name for the media settings in the **Name** field, and click **Save**.

   **Note:** If you need to delete a group of settings you have created, select the name of the settings from the list and click **Delete**.
4. Do the following as necessary:
   • Select the name of a media setting as the **Media Type** setting and use it to print.
   • To export the settings, click **Custom Settings**, select the name of the media settings, click **Export**, select a location, and enter a file name.
   • To import settings, click **Custom Settings**, select the name of the media settings, click **Import**, select the file you want to use, and click **Open**. Then use these settings to print.

**Parent topic:** Saving, Sharing, and Customizing the Printer Settings

**Editing Print Setting Displays - Windows**

You can arrange the displayed print settings so you can easily select the settings you use most often.

1. Click the **Utility** tab in the printer software.
2. Select **Menu Arrangement**.
3. Select the item you want to edit.
4. Order or group items in the List box.
   • To move and reorder items, drag and drop them in the list.
   • To add a new group (folder), click Add Group.
   • To delete a group (folder), select the group and click Delete Group.
To hide a group, drag and drop it to Not Display.

Note: If you delete a group, the group folder is deleted but the items within the folder remain.

5. Click Save.

Parent topic: Saving, Sharing, and Customizing the Printer Settings

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window:

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

**Parent topic:** Printing with Windows

71
Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select **Printer Settings**.
   
   You see the printer settings window.
3. Click the **Utility** tab.
   
   You see these options:
4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.

Parent topic: Printing with Windows

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.

You see this window:

![Software Update Settings Window](image)

3. Do one of the following:
   - To change how often the software checks for updates, select a setting in the Check every menu.
   - To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
Printing with OS X

You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software on Epson’s support website.

Selecting Basic Print Settings - OS X
Selecting Roll Paper Settings - OS X
Selecting Print Layout Options - OS X
Managing Color - OS X
Sizing Printed Images - OS X
Selecting Printing Preferences - OS X
Printing Your Document or Photo - OS X

Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X

Select the basic settings for the photo or document you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.
   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.
3. Select your product as the Printer setting.

![Printer Selection](image-url)
4. If necessary, click the arrow next to the Printer setting or the **Show Details** button to expand the print window.

You see the expanded printer settings window for your product:

![Expanded Printer Settings Window]

**Note:** The print window may look different, depending on the version of OS X and the application you are using.

5. Select the **Copies** and **Pages** settings as necessary.

**Note:** If you do not see these settings in the print window, check for them in your application before printing.
6. Select the size of the paper you loaded as the **Paper Size** setting.
   - To print a borderless photo, select a paper size with a **Borderless** option.
   - To print on roll paper, select a roll paper size or one with a **Borderless** option.

   **Note:** For roll paper, make sure the maximum width of your photo is set to 13 inches to fit in the width of your roll paper (set the margins to 0 in your application software).

   - To print on paper loaded in the manual feed tray, select a paper size with a **Rear Fine Art** option.

   **Note:** You can reduce or enlarge the size of the printed image by selecting **Paper Handling** from the pop-up menu and selecting a scaling option.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

7. Choose portrait or landscape as the **Orientation** setting.

8. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

9. Select **Printer Settings** from the pop-up menu.

   ![Printer Settings menu](image)

   **Note:** In certain programs, you may need to select **Advanced** before you can select **Printer Settings**. For more information about printer settings, click the ? button.
You see these settings:

10. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the media type settings list for details.

   **Note:** The ink type may change depending on the size and type of paper you select. To avoid changing black ink more often than necessary, set the printer to the type of black ink you usually use.

11. Select one of the following as the **Print Mode** setting:
   - Select **AccuPhoto HG** for any type of photographic printing.
   - Select **Black/Grayscale** when using plain paper.

12. Select one of the following as the **Color Mode** setting:
   - **EPSON Standard (sRGB):** Increases the contrast in images. Click the **Advanced Color Settings** tab to use advanced color controls.
   - **EPSON Vivid:** Processes colors to create standard hues. Click the **Advanced Color Settings** tab to use advanced color controls.
   - **Adobe RGB:** Matches image colors to the Adobe RGB color standard. Use this setting if your source file was captured in Adobe RGB. Click the **Advanced Color Settings** tab to use advanced color controls.
• **Off (No Color Adjustment):** Turns off color management in your printer software so you can manage color using only your application software.

**Note:** If desired, you can instead use ColorSync to manage colors. In most cases, you get better results by applying color management in your application, rather than in the printer driver.

13. Select the **Output Resolution** setting you want to use.
14. Select any of the available print options.

---

**Advanced Color Settings - OS X**

When you click the **Advanced Color Settings** tab, you see the screen shown here.

You can specify values for adjusting brightness, contrast, saturation, and individual Cyan, Magenta, and Yellow color tones.
Note: If you selected Black/Grayscale as your Print Mode, you cannot select a Color Mode and you can adjust only the Gamma, Brightness, and Contrast settings.

You can select Fix Photo from the Color Mode menu. The Fix Photo feature improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

Parent topic: Selecting Basic Print Settings - OS X
Output Resolution Settings - OS X

You can select any of the Output Resolution settings to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

- **Economy**
  For fast printing with reduced quality.
- **Draft**
  For draft printing on photo paper.
- **Normal**
  For everyday text and image printing.
- **Photo**
  For photos and graphics with good quality and print speed.
- **Best Photo**
  For photos and graphics with high print quality.
- **Photo RPM**
  For the best print quality but the slowest print speed.

Parent topic: Selecting Basic Print Settings - OS X

Print Options - OS X

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

- **High Speed**
  Speeds up printing but may reduce print quality.
- **Mirror Image**
  Flips the printed image left to right.
- **Gloss Optimizer**
  Adds a glossy finish to your print.

Parent topic: Selecting Basic Print Settings - OS X

Selecting Roll Paper Settings - OS X

To print on roll paper, you select the roll paper size and roll paper options from the Printer Settings menu.

1. Select Manage Custom Sizes as the Paper Size setting.
2. Click +, double-click Untitled, and enter a name for your roll paper size.
3. Enter one of the following as the **Width** setting:
   - **8.3** for 8.3-inch (211 mm) wide roll paper
   - **12.95** for 13-inch (330 mm) wide roll paper

   **Note:** Make sure your image fits within the width of your roll paper.

4. Enter the length of your roll paper image as the **Height** setting (up to 129 inches [327.66 cm]).
5. Set the margin setting to **0**.
6. Click **OK**.
7. Select your new custom roll paper size as the **Paper Size** setting.
8. Select **Page Layout Settings**.
   You see this window:

   ![Page Layout Settings](image)

   **Note:** Some settings may not be available, depending on the Roll Paper option you selected for your Paper Size.

9. Select the following settings as necessary:
   - Click **Print page frame** to print a cutting guideline around your images.
   - Adjust the amount of image expansion when printing borderless images.
Note: This option is available only when you choose a Paper Size setting with a Borderless option.

10. Click Print.

Parent topic: Printing with OS X

Selecting Print Layout Options - OS X

You can select a variety of layout options by selecting Layout from the pop-up menu on the print window.

- To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.
- To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
- To invert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.

Parent topic: Printing with OS X

Managing Color - OS X

You can adjust the Color Matching settings to fine-tune the colors in your printout, or turn off color management in your printer software.
1. Select **Color Matching** from the pop-up menu in the print window.

![Color Matching Menu](image)

2. Select one of the available options.

**Color Matching Options - OS X**

**Parent topic:** Printing with OS X

**Color Matching Options - OS X**

You can select from these settings on the **Color Matching** menu.

**ColorSync**

Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.

**EPSON Color Controls**

Lets you manage color using controls in your printer software or turn off color management.

**Parent topic:** Managing Color - OS X

**Related tasks**

Selecting Basic Print Settings - OS X
Sizing Printed Images - OS X

You can adjust the size of the image as you print it by selecting **Paper Handling** from the pop-up menu on the Print window.

![Paper Handling Settings](image)

- To collate multiple copies into sets of documents, select the **Collate pages** checkbox.
- To print only selected pages in a multi-page document, select an option from the **Pages to Print** pop-up menu.
- To adjust the order in which pages are printed, select an option from the **Page Order** pop-up menu.
- To scale the image to fit on a specific paper size, select the **Scale to fit paper size** checkbox and select a paper size from the **Destination Paper Size** pop-up menu.
- To restrict scaling of the image to reduced sizing, select the **Scale down only** checkbox. (Deselect this checkbox when enlarging the image.)

Parent topic: **Printing with OS X**

Selecting Printing Preferences - OS X

You can select printing preferences that apply to all the print jobs you send to your product.

1. In the Apple menu or the Dock, select **System Preferences**.
2. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**.
3. Select **Options**.
You see a screen like this:

4. Select any of the available printing options.
5. Click **OK**.

**Printing Preferences - OS X**

Parent topic: **Printing with OS X**

**Printing Preferences - OS X**

You can select from these settings on the **Options** tab.

**Check Paper Width Before Printing**
Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print speed.

**Thick Paper**
Lets you select the thickness of your paper or media.

**Warning Notifications**
Lets you choose whether or not to receive warning notifications from the printer software for various operating conditions.

**Establish bidirectional communication**
Allows the product to communicate with the computer. Do not change the default setting unless you experience issues when using a shared printing pool.

Parent topic: **Selecting Printing Preferences - OS X**

**Printing Your Document or Photo - OS X**

Once you have selected your print settings, you are ready to print.
Click **Print** at the bottom of the print window.

![Printer Settings](image)

1. Click the printer icon when it appears in the Dock.
You see the print status window:

2. Select the following options as necessary for your version of OS X:

   • To cancel printing, click the print job and click □ or **Delete**.
   • To pause a print job, click the print job and click ■ or **Hold**. To resume a print job, click the paused print job and click ■ or **Resume**.
   • To pause printing for all queued print jobs, click **Pause** or **Pause Printer**.
   • To display other printer information, click **Settings** or **Supply Levels**.

   **Parent topic:** Printing Your Document or Photo - OS X

**Managing Colors with Profiles**

For the most up-to-date Premium ICC profiles and information on using them in a color-managed workflow, go to [http://www.epson.com/scp400profiles](http://www.epson.com/scp400profiles) (U.S.) or [http://www.epson.ca/scp400profiles](http://www.epson.ca/scp400profiles) (Canada).

**Parent topic:** Printing from a Computer
Printing on CDs/DVDs

Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.

- Loading a CD/DVD
- Removing a Printed CD/DVD
- Printing on CDs/DVDs from a Computer

Loading a CD/DVD

You can use your product and the Epson Print CD software that came with it to print label designs directly onto ink jet-printable CDs or DVDs. To prevent errors, you should burn files, music, or video onto your CD or DVD before printing.

**Warning:** Do not open the front manual feed tray or load the CD/DVD tray while your product is operating. This could damage your product.

1. Turn on your product.
2. Open the front cover.
3. Open the front manual feed tray.
4. Slide the edge guide all the way to the left.

5. Place your disc on the included CD/DVD tray with the label side up.

**Caution:** Use the CD/DVD tray supplied with the product. Using a different tray could damage the product, tray, or disc or cause the product to malfunction.
6. Place the CD/DVD tray against the right side of the front manual feed tray and slide the edge guide against the tray.

7. Slide in the CD/DVD tray until the arrows on the CD/DVD tray align with the arrows on the front manual feed tray. Make sure the CD/DVD tray is flush against the right side.

Parent topic: Printing on CDs/DVDs

Removing a Printed CD/DVD

After you print on your CD or DVD, the tray ejects partially from your product.
1. Pull out the CD/DVD tray and remove the disc from it.

2. Close the front manual feed tray.

Parent topic: Printing on CDs/DVDs

Printing on CDs/DVDs from a Computer

Before printing directly on CDs or DVDs from your computer, make sure you have set up your product as described on the Start Here sheet, and installed the Epson Print CD software.

Starting Epson Print CD - Windows
Printing Your CD/DVD Design - Windows
Starting Epson Print CD - OS X
Printing Your CD/DVD Design - OS X

Parent topic: Printing on CDs/DVDs

Starting Epson Print CD - Windows

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special effects.

1. Select the Epson Print CD icon on your Windows Desktop.
You see a screen like this:

![Screen Image]

2. Use the buttons on the left side of the screen to select a pre-designed template or add a background image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.

Parent topic: Printing on CDs/DVDs from a Computer

**Printing Your CD/DVD Design - Windows**

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Open your file in Epson Print CD and click Print.
You see a screen like this:

![Print Settings](image)

2. Make sure your product is selected as the **Printer** setting.
3. To see how your design will look without printing on the disc, click **Test Print** and follow the instructions on the screen.
4. When you are ready to print on the disc, click the **Print** button on the screen.
5. Click **Print**.

**Note:** If you need to adjust the print position or print quality, see the Epson Print CD Help utility for instructions.

**Parent topic:** Printing on CDs/DVDs from a Computer

### Starting Epson Print CD - OS X

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special effects.

1. Open the Epson Print CD program in the **Applications > Epson Software > Print CD** folder on your Mac.
You see a screen like this:

2. Use the icons on the left side of the screen to add a background image, picture, text, or graphic elements.

3. When you are finished creating your design, make sure you save it.

Parent topic: Printing on CDs/DVDs from a Computer

**Printing Your CD/DVD Design - OS X**

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Open your file in Epson Print CD and select **Print** from the File menu.
2. Make sure your product is selected as the **Printer** setting.
3. To see how your design will look without printing on the disc, select **Test Print** and follow the instructions on the screen.
4. When you are ready to print on the disc, click the **Print** button on the screen.

**Note:** If you need to adjust the print position or print quality, see the Epson Print CD Help utility for instructions.

**Parent topic:** Printing on CDs/DVDs from a Computer
Replacing Ink Cartridges

When an ink cartridge is expended, you need to replace it. You may also need to replace a cartridge that is more than six months old, or if your printouts do not look their best, even after cleaning and aligning the print head.

**Note:** Please dispose of your used Epson branded ink cartridges responsibly and in accordance with local requirements. If you would like to return your used ink cartridges to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge Status
Purchase Epson Ink Cartridges
Removing and Installing Ink Cartridges

Check Cartridge Status

Your product and its printing software will let you know when an ink cartridge is low or expended.

Checking Cartridge Status with Windows
Checking Cartridge Status with OS X

Parent topic: Replacing Ink Cartridges

Checking Cartridge Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at any time using a utility on your Windows computer.

1. To check your cartridge status, access the Windows Desktop and double-click the product icon in the Windows taskbar.
2. Replace or reinstall any ink cartridge indicated on the screen.

   **Note:** If any of the cartridges installed in the product are broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select **Monitoring Preferences**.
4. Deselect the **See Low Ink Reminder alerts** checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the **Display Epson Offers** checkbox.

Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges
Checking Cartridge Status with OS X

You can check your cartridge status using a utility on your Mac.

1. In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.

2. Select EPSON Status Monitor.
   You see a window like this:

   ![EPSON Status Monitor Window]

3. Do the following as necessary:
   • To update the ink cartridge status, click Update.
- Replace or reinstall any ink cartridge indicated on the screen.

**Note:** If any of the cartridges installed in the product is broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

**Parent topic:** Check Cartridge Status

**Related tasks**

Removing and Installing Ink Cartridges

Purchase Epson Ink Cartridges

You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

**Note:** We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink is used for charging, the rest is available for printing. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

**Ink Cartridge Part Numbers**

**Parent topic:** Replacing Ink Cartridges

### Ink Cartridge Part Numbers

Use these part numbers when you order or purchase new ink cartridges.

**Note:** For best printing results, use up a cartridge within 6 months of opening the package.

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Black</td>
<td>T324120</td>
</tr>
<tr>
<td>Cyan</td>
<td>T324220</td>
</tr>
<tr>
<td>Magenta</td>
<td>T324320</td>
</tr>
<tr>
<td>Yellow</td>
<td>T324420</td>
</tr>
<tr>
<td>Ink color</td>
<td>Part number</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Red</td>
<td>T324720</td>
</tr>
<tr>
<td>Orange</td>
<td>T324920</td>
</tr>
<tr>
<td>Matte Black</td>
<td>T324820</td>
</tr>
<tr>
<td>Gloss Optimizer (2-pack)</td>
<td>T324020</td>
</tr>
</tbody>
</table>

**Parent topic:** Purchase Epson Ink Cartridges

### Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new cartridges immediately after removing the old ones.

**Caution:** Leave your old cartridges in the printer until you are ready to replace them to prevent the print head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

1. Turn on your product.
2. Lift up the printer cover.
3. Press the △ ink button. The print head moves to the ink replacement position.

4. Press the latch and open the ink cartridge cover as shown.
5. Squeeze the tab on the cartridge and lift the cartridge straight up to remove it.

![Image showing the removal of a cartridge]

**Note:** Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

**Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges out of the reach of children.

6. Before unpacking the cartridge, gently shake it four or five times as shown. Then remove the cartridge from the package and remove the yellow tape from the bottom of the cartridge.

![Image showing the shaking and removal of a cartridge]

**Caution:** Cartridges may make a clicking sound when you shake them. Do not remove any other labels or seals, or ink will leak. Do not touch the green chip on the cartridge.
7. Insert the new cartridge into the holder and push it down until it clicks into place.

8. Close the cartridge cover and push it down until it clicks into place.

9. Close the printer cover.

Wait for your product to check the ink cartridges and charge the ink delivery system, if necessary. Do not turn off the product during ink charging.
**Caution:** If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. The valve in the ink supply port is designed to contain any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with the label facing up; do not store cartridges upside-down.

**Parent topic:** Replacing Ink Cartridges
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.
If running these utilities does not solve the problem, you may need to replace the ink cartridges.

Print Head Maintenance
Print Head Alignment
Using Ink Density Optimization
Cleaning the Paper Guide Rollers

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.
You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Parent topic: Adjusting Print Quality
Related tasks
Removing and Installing Ink Cartridges

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Control Panel
Checking the Nozzles Using a Computer Utility
Parent topic: Print Head Maintenance

Checking the Nozzles Using the Control Panel

You can check the print head nozzles using your product's control panel.

1. Load a few sheets of plain paper in the sheet feeder.
2. Turn the product off.
3. Press and hold the paper/cancel button and turn the product on.
   The product turns on and prints a nozzle check pattern.
4. Check the printed pattern to see if there are gaps in the lines.
   
   **Print head is clean**
   
   ![Print head is clean pattern]

   **Print head needs cleaning**
   
   ![Print head needs cleaning pattern]

5. If there are gaps or the pattern is faint, clean the print head.

   If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

   **Parent topic:** Print Head Nozzle Check

   **Related tasks**
   - Removing and Installing Ink Cartridges
   - Cleaning the Print Head Using the Control Panel
Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.

1. Load a few sheets of plain paper in the sheet feeder.
2. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
   • **OS X**: In the Apple menu or the Dock, select *System Preferences*. Select *Print & Fax, Print & Scan*, or *Printers & Scanners*, select your product, and select *Options & Supplies*. Select *Utility* and select *Open Printer Utility*.
3. Select **Nozzle Check**.
   You see a window like this:

   ![Nozzle Check Window](image)

   To perform a nozzle check, make sure that the printer is on and connected to the computer. Make sure that the CD/DVD tray is removed and that the front manual feed tray is closed; otherwise, "Nozzle Check" cannot be performed. Also make sure that A4 or Letter size plain paper is loaded in auto sheet feeder. Click [Print] to print a nozzle check pattern or click [Cancel] to quit.

4. Click **Print**.
5. Check the printed pattern to see if there are gaps in the lines.

   **Print head is clean**

   ![Print head is clean pattern]

   **Print head needs cleaning**

   ![Print head needs cleaning pattern]

6. If there are no gaps, click **Finish**.
   
   If there are gaps or the pattern is faint, clean the print head.

   If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** [Print Head Nozzle Check](#)

**Related tasks**
- [Removing and Installing Ink Cartridges](#)
- [Cleaning the Print Head Using a Computer Utility](#)
Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

**Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

Related tasks
Removing and Installing Ink Cartridges

Cleaning the Print Head Using the Control Panel

You can clean the print head using your product's control panel.

1. Press and hold the Δ ink button for 3 seconds or more to start the head cleaning process. Head cleaning takes approximately 3 minutes to complete.

2. When the cleaning cycle is finished, you can check to see if the nozzles are clean by running a nozzle check.
3. Check the printed pattern to see if there are gaps in the lines.

**Print head is clean**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Print head needs cleaning**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. If there are gaps or the pattern is faint, clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Cleaning

**Related tasks**
- Removing and Installing Ink Cartridges
- Checking the Nozzles Using the Control Panel

**Cleaning the Print Head Using a Computer Utility**

You can clean the print head using a utility on your Windows computer or Mac.

1. Load a few sheets of plain paper in the sheet feeder.
2. Do one of the following:
   • **Windows**: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
   • In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax, Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

   **Note**: Do not use the **Clean Print Heads** button on the **Utility** tab of the driver to perform head cleaning on your product. Use only the Epson Printer Utility 4 utility.

3. Select **Head Cleaning**.
   
   You see a window like this:

   ![Head Cleaning window](image)

   Make sure that the CD/DVD tray is removed and that the front manual feed tray is closed; otherwise “Head Cleaning” cannot be performed. Click [Start] to clean the print head nozzles. Because cleaning consumes some ink, only clean the print head when faint areas or gaps appear in your printout. Use the “Nozzle Check” utility first to confirm that the print head needs to be cleaned. If the ink is low or expended, replace the cartridge first.

   Caution: Do not open or close tray.

4. Click **Start** to begin the cleaning cycle.

   The power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is finished.
Caution: Never turn off the product during a cleaning cycle or you may damage it.

5. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle Check Pattern and click Print.

6. Check the printed pattern to see if there are gaps in the lines.
   
   **Print head is clean**
   
   ![Pattern image]
   
   **Print head needs cleaning**
   
   ![Pattern image]

   - If there are no gaps, click Finish.
   - If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Removing and Installing Ink Cartridges
Checking the Nozzles Using a Computer Utility

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using a Computer Utility

Parent topic: Adjusting Print Quality

Aligning the Print Head Using a Computer Utility

You can align the print head using a utility on your Windows computer or Mac.

1. Load a few sheets of plain paper in the sheet feeder.
2. Do one of the following:
   • Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
   • In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
3. Select Print Head Alignment, then click Next.
You see a window like this:

![Print Head Alignment window](image)

The Print Head Alignment utility fixes vertical misalignment, horizontal banding, and blurry printouts.

Make sure that the CD/DVD tray is removed and that the front manual feed tray is closed; otherwise, 'Print Head Alignment' cannot be performed.

4. Click **Next** then click **Print** to print an alignment sheet.

**Note:** Do not cancel printing while you are printing a head alignment pattern.
You see a window like this:

5. Check the printed pattern and follow the instructions on the screen to choose the number representing the best printed pattern for each set.
   • After choosing each pattern number, click **Next**.
   • If no patterns are aligned in one or more of the sets, choose the closest one in each set and click **Realignment**. Then print another alignment sheet and check it.

   **Note:** Click **Skip** (where available) if you want to skip a particular alignment sheet.

6. When you are done, click **Finish**.

Parent topic: Print Head Alignment
Using Ink Density Optimization

Your product can automatically agitate the ink cartridges to eliminate any inconsistencies in ink density, called Auto Ink Density Optimization.

**Note:** Ink Density Optimization does not consume ink.

By default, the setting is set to **On** and we recommend leaving it turned on. If you turn off Auto Ink Density Optimization, run the Ink Density Optimization utility manually once a week, as described here.

1. Do one of the following:
   - **Windows:** Access the Windows Desktop, right-click the product icon in the Windows taskbar, and select **Printer Settings**. Click the **Utility** tab and select **Printer and Option Information**.
   - **OS X:** In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, **Print & Scan**, or **Printers & Scanners**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.

2. Select **Ink Density Optimization** and follow the on-screen instructions.

   The power light starts flashing. Optimization is finished in about 30 seconds.

   **Note:** Do not open the printer cover or front manual feed tray while the power light is flashing.

Parent topic: Adjusting Print Quality

Cleaning the Paper Guide Rollers

If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.

If plain paper isn’t effective, you can use Epson Ink Jet Printer Cleaning Sheets (part number S041150) to clean the rollers. A cleaning sheet will help remove dust from the rollers, which can cause a loss of traction and prevent paper from feeding properly.

**Caution:** Remove the instruction sheet attached to the Epson Ink Jet Printer Cleaning Sheets and do not follow the steps on it; they are not correct for your printer. Do not use the cleaning sheets that come with certain Epson special papers; they may jam inside your printer.
1. Load several sheets of plain paper (or a cleaning sheet) of this size in the sheet feeder: A3 (11.7 × 16.5 inches [297 × 420 mm])

   **Note:** If you are using a cleaning sheet, insert the sheet with the adhesive side facing up and the non-adhesive portion of the page at the bottom.

2. Press the paper/cancel button to feed the paper through the product.
3. Repeat these steps as necessary until no ink appears on the back of your printouts. If you are using a cleaning sheet, run it through up to three times.

**Parent topic:** Adjusting Print Quality
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

**Caution:** Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may damage it. Do not place anything on top of the cover or use the cover as a writing surface, or it could get permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper and the roll paper holders from the product.
5. Clean the paper support and manual feed tray using a soft brush or a dry microfiber cloth.
6. Close the paper support, manual feed tray, output tray, and any covers.
7. Clean the outer case with a soft cloth dampened with a mild detergent.
8. Plug the power cable back in and turn on the product.
9. Load several sheets of plain paper (or a cleaning sheet) in the sheet feeder and clean the paper guide.

Close the rear paper support and output tray when you are not using the product to help keep it clean.

**Parent topic:** Cleaning and Transporting Your Product

Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described here.

**Caution:** During transportation and storage, follow these guidelines:

• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the product from printing.

**Note:** Before storing your product for a long period, replace low, expended, or expired ink to help prevent the print head from drying out. Store your product in a cool, dry place.

1. Turn off the product and disconnect all cables.
2. Remove all the paper from the product.
3. Remove the roll paper holders.
4. Close the rear paper support and the output tray.
5. Open the printer cover.
6. Secure the ink cartridge holder to the case with tape. Leave the ink cartridges installed to avoid damaging the product.

7. Close the printer cover.

8. Place the product in its original packing materials, if possible, or use equivalent materials with cushioning around the product. Make sure the box adequately protects the product control panel.

9. After unpacking the product, be sure to remove all of the tape.

   **Note:** Some tape may be difficult to remove if left in place for a long time. Remove the tape immediately after transporting the product.

Keep the product level during transportation. If print quality has declined when you print again, clean and align the print head.

**Parent topic:** Cleaning and Transporting Your Product

**Related concepts**

- Print Head Cleaning
- Print Head Alignment
Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates
Product Light Status
Running a Product Check
Solving Setup Problems
Solving Network Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving CD/DVD Problems
Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software. Visit the driver download site at (U.S. downloads or Canadian downloads).

- **Windows**: Your printer software automatically checks for updates. You can also manually update the software by:
  - Accessing the Windows Desktop, right-clicking the product icon in the Windows taskbar, then clicking **Software Update**.
  - Clicking on the **Utility** tab in the printer settings window and selecting **Driver Update**

  You can also update the software by selecting **EPSON Software Updater** in the **EPSON** or **EPSON Software** program group, accessible by the **Start** button, or on the **Start** or **Apps** screens, depending on your version of Windows.

- **OS X**: You can manually update the software by opening the **Applications > Epson Software** folder and selecting **EPSON Software Updater**.

Parent topic: Solving Problems
**Product Light Status**

You can often diagnose problems with your product by checking its lights.

<table>
<thead>
<tr>
<th>Lights</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>network</td>
</tr>
<tr>
<td>2</td>
<td>power</td>
</tr>
<tr>
<td>3</td>
<td>paper/cancel</td>
</tr>
<tr>
<td>4</td>
<td>ink</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Light status</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power light is on</td>
<td>The product is turned on and ready to print.</td>
</tr>
</tbody>
</table>
| The power light is flashing | One of the following has occurred:  
  - The product is starting up  
  - The product is shutting down  
  - Ink Density Optimization is in progress  
  - Ink cartridges are being replaced  
  - The product is checking the network connection  
  - Head cleaning is in progress  
  - The product is receiving data or printing  
  - The firmware is being updated |
<table>
<thead>
<tr>
<th>Light status</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The left side of the network light is on</td>
<td>The wireless LAN is active.</td>
</tr>
<tr>
<td>The right side of the network light is on</td>
<td>The Ethernet connection is active.</td>
</tr>
<tr>
<td>The 🌇 power light is flashing The left side of</td>
<td>The product is receiving data or printing while connected to an Ethernet or wireless network.</td>
</tr>
<tr>
<td>the network light is flashing</td>
<td></td>
</tr>
<tr>
<td>The right side of the network light is flashing</td>
<td>One of the following has occurred:</td>
</tr>
<tr>
<td></td>
<td>• An error occurred during WPS network setup. Make sure the router is in setup mode and is not too far away (less than 10 feet [3 meters]). Another</td>
</tr>
<tr>
<td></td>
<td>wireless device may be trying to connect using WPS. Wait a few minutes and try again.</td>
</tr>
<tr>
<td></td>
<td>• You tried to connect to a wireless network while the product was connected to an Ethernet connection. Disconnect the Ethernet connection before</td>
</tr>
<tr>
<td></td>
<td>setting up a wireless connection.</td>
</tr>
<tr>
<td>Both sides of the network light are flashing at</td>
<td>You are entering a WPS PIN code or firmware is being updated.</td>
</tr>
<tr>
<td>the same time</td>
<td></td>
</tr>
<tr>
<td>Both sides of the network light are flashing</td>
<td>WPS network setup is in progress or the product is starting up.</td>
</tr>
<tr>
<td>alternately</td>
<td></td>
</tr>
<tr>
<td>The ∆ ink light is on</td>
<td>An ink cartridge is expended, not installed, not detected, or not compatible with your product. Install or replace the ink cartridge.</td>
</tr>
<tr>
<td>The ∆ ink light is flashing</td>
<td>One of the ink cartridges is running low. Prepare a new ink cartridge.</td>
</tr>
<tr>
<td>The 🎨 ‌️ paper/cancel light is on</td>
<td>One of the following has occurred:</td>
</tr>
<tr>
<td></td>
<td>• Paper or a CD/DVD is not loaded</td>
</tr>
<tr>
<td></td>
<td>• The CD/DVD tray is not loaded in the product correctly</td>
</tr>
<tr>
<td></td>
<td>• Multiple sheets of paper fed at the same time</td>
</tr>
<tr>
<td></td>
<td>• Roll paper has run out. Load a new paper roll.</td>
</tr>
<tr>
<td></td>
<td>Insert the paper or tray correctly and press the 🎨 ‌️ paper/cancel button.</td>
</tr>
<tr>
<td>Light status</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------</td>
</tr>
</tbody>
</table>
| The paper/cancel light is flashing | One of the following has occurred:  
  • The printer cover is open. Close the printer cover.  
  • Paper or the CD/DVD tray is jammed. Remove the jammed paper.  
  • Printing was canceled while printing on thick paper, or on a CD or DVD. Remove the paper or disc and press the paper/cancel button.  
  • The source selected in the printer driver does not match the paper source. Change the paper source in the printer driver to match the correct paper source and press the paper/cancel button.  
  • A nozzle check was started without paper in the auto sheet feeder. Load paper and press the paper/cancel button. |
| The paper/cancel and ink lights are flashing simultaneously | An unrecoverable error has occurred. Turn the product off and then back on again. |
| The paper/cancel and ink lights are flashing alternately | One of the following has occurred:  
  • The product's ink pads are at the end of their service life. Contact Epson Support to obtain replacement pads. You cannot use the product until the pads are replaced.  
  • The front manual feed tray is not in the correct position. When printing on thick paper, or a CD or DVD, open the front manual feed tray and position the paper or tray correctly. |

**Parent topic:** Solving Problems

**Related references**
- Paper Feeding Problems
- Paper Jam Problems - Sheet Feeder
- Paper Jam Problems - Rear Manual Feed Tray
- Paper Jam Problems - Thick Media or CD/DVD
- Paper Jam Problems - Roll Paper
- Where to Get Help

**Related tasks**
- Using Ink Density Optimization
Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Make sure plain paper is loaded in the sheet feeder.
2. Turn the product off.
3. Press and hold the paper/cancel button, then press the power button.
   The nozzle check pattern prints.
4. Do one of the following, depending on the results of the product check:
   • If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected settings. Check the other solutions in this manual or try uninstalling and reinstalling your printer software.
   • If the page prints but the nozzle check pattern has gaps, clean or align the print head.
   • If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Solving Setup Problems

Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems
Noise After Ink Installation

If you hear noises from your product after installing ink, check the following:

- The first time you install ink cartridges, the product must charge its print head. Wait until charging finishes before you turn off the product, or it may charge improperly and use excess ink the next time you turn it on. Your product is finished charging the print head when the \( \bigcirc \) power light stops flashing.

- If the product’s print head stops moving or making noise, and the charging process has not finished after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

- Turn off the product, then make sure the ink cartridges are inserted completely and the ink cartridge cover is closed completely. Also make sure no packing material remains in the product. Wait a moment, then turn the product back on to clear the error.

Parent topic: Solving Setup Problems

Software Installation Problems

If you have problems while installing your product software, try these solutions:

- Make sure your product is turned on and any necessary cables are securely connected at both ends. If you still have problems installing software, disconnect the cable and carefully follow the instructions on the \textit{Start Here} sheet. Also make sure your system meets the requirements for your operating system.

- Close any other programs, including screen savers and virus protection software, and install your product software again.

- In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.

- If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your System Administrator.

- If you are printing over a network, make sure your product is set up properly on the network.

Parent topic: Solving Setup Problems

Related references

Windows System Requirements
OS X System Requirements

Related tasks

Uninstalling Printing Software - Windows
Uninstalling Product Software - OS X
Solving Network Problems

Check these solutions if you have problems setting up or using your product on a network.

**Note**: Breakdown or repair of this product may cause loss of network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point

If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the WiFi light on your product is not solid green, make sure you press the Wi-Fi button on the product within 2 minutes of pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

- Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

**Note**: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

- Verify that your router or access point is operating correctly by connecting to it from your computer or another device.

- You may need to disable the firewall and any anti-virus software on your wireless router or access point.

- Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product’s MAC address to your router’s address list. To obtain your product’s MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.

- If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.
• If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify connection using your product control panel.

• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.

• Make sure your product is not connected to a guest network.

• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product’s network settings to their factory defaults.
  2. Windows only: uninstall your product software.
  3. Initialize your router following the instructions in your router documentation.

  Note: If you are reading these instructions online, you will lose your Internet connection when you initialize your router, so note the next step before initializing it.

  4. Download your product software from the Epson website using the instructions on the Start Here sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

  Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.
**Product Does Not Appear in OS X Printer Window**

If your product does not appear in the OS X printer window, try these solutions:

- Turn your product off, wait 30 seconds, then turn it back on again.
- If you are connecting the product via Wi-Fi Protected Setup (WPS) and the left side of the network light on your product is not solid blue, make sure you press the **Wi-Fi** button on the product within 2 minutes of pressing the WPS button on your router. Hold down the **Wi-Fi** button on the product for 3 seconds.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

**Cannot Print Over a Network**

If you cannot print over a network, try these solutions:

- Make sure that your product is turned on.
- Make sure you install your product's network software as described in your product documentation.
- Print a network status sheet and verify that the network settings are correct. If the network status is **Disconnected**, check any cable connections and turn your product off and then on again.
- If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
- Make sure your computer and product are both using the same wireless network.
- If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point. Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

**Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.
• Check to see if your wireless router or access point has an enabled Privacy Separator function that is preventing printing from a device over the network. See your router or access point documentation for instructions on disabling the Privacy Separator function.

• If you are connecting the product via Wi-Fi Protected Setup (WPS) and the left side of the network light on your product is not solid blue, make sure you press the Wi-Fi button on the product within 2 minutes of pressing the WPS button on your router. Hold down the Wi-Fi button on the product for 3 seconds.

• Check your wired LAN router or access point to see if the LED for the port to which your product is connected is on or flashing. If the link LED is off, try the following:
  • Make sure the Ethernet cable is securely connected to your product and to your router, access point, switch, or hub.
  • Try connecting your product to a different port or a different router, access point, switch, or hub.
  • Try connecting with a different Ethernet cable.
  • Try printing to your product from another computer on the network.

  **Note:** If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5 GHz) mode. See your router documentation for instructions.

• If you are connecting the product via EpsonNet Setup and the left side of the network light on your product is not solid blue, make sure your product software was installed correctly. If necessary, reinstall your software.

**Parent topic:** Solving Network Problems

**Related concepts**

Uninstall Your Product Software

**Related tasks**

Printing a Network Status Sheet

**Related topics**

Wi-Fi or Wired Networking

### Solving Paper Problems

Check these sections if you have problems using paper with your product.

**Paper Feeding Problems**

**Paper Jam Problems - Sheet Feeder**
Paper Feeding Problems

If you have problems feeding paper, try these solutions:

- If paper does not feed into the sheet feeder, remove the paper and fan the edges to separate the sheets. Reload paper against the right side and slide the edge guide against it. Do not load too many sheets in the sheet feeder at once and make sure the product cover is closed.

- When using the sheet feeder, do not load paper above the arrow mark on the left edge guide. Load only one sheet of compatible paper when using the front manual feed tray.

- Load only one sheet of media in the front manual feed tray. For posterboard, make sure there is enough space behind the product for the media to feed through.

- If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.

- If you cannot insert paper easily into the front manual feed tray, make sure the paper is perfectly flat and not curled.

- If you are printing on roll paper or with the sheet feeder, make sure the manual feed tray is not extended. Extend it only to load fine art paper or posterboard.

- If paper loaded using the front manual feed tray does not feed, make sure you installed the paper correctly and guided it all the way into the product.

- Do not load more than the recommended number of sheets.

- Make sure paper is loaded in the correct orientation. Load cut sheets in the sheet feeder vertically.

- Make sure your paper meets the specifications for your product.

- If paper dust builds up on the rollers, they may lose traction and become unable to feed paper properly. Clean the paper guide.

- If roll paper does not feed, cut the end straight across and uncurl it by rolling it backward, if necessary. Then reload the paper.

- If thick media does not feed, make sure you are loading it straight into the product, not at an angle.

- If paper jams when you print on both sides of the paper, try loading fewer sheets.
• For best results, follow these guidelines:
  • Use new, smooth, high-quality paper that is not damp, curled, creased, old, too thin, or too thick.
  • Load paper printable side up.
  • Follow any special loading instructions that came with the paper.

**Parent topic:** Solving Paper Problems

**Related references**

- Paper Jam Problems - Sheet Feeder
- Paper Jam Problems - Rear Manual Feed Tray
- Paper Jam Problems - Thick Media or CD/DVD
- Paper Jam Problems - Roll Paper
- Paper Ejection Problems
- Cut Sheet Media Loading Capacity
- Paper Specifications

**Related topics**

- Loading Media

---

**Paper Jam Problems - Sheet Feeder**

If paper has jammed in the sheet feeder, try these solutions:

1. Cancel the print job from your computer, if necessary.
2. Carefully remove any paper jammed in the sheet feeder or the output tray.
3. Open the printer cover.

4. Slowly pull any jammed paper out of the product.

5. Close the printer cover and press the paper/cancel button to clear the error.

6. If the paper/cancel light is still flashing, turn off the product, wait a moment, then turn it back on.

**Note:** If you are unable to remove the paper or clear the error, contact Epson for support.

**Parent topic:** Solving Paper Problems
Related references
Paper Jam Problems - Rear Manual Feed Tray
Paper Jam Problems - Thick Media or CD/DVD
Paper Jam Problems - Roll Paper

Paper Jam Problems - Rear Manual Feed Tray
If paper has jammed in the rear manual feed tray, try these solutions:
1. Cancel the print job from your computer, if necessary.
2. Press the paper/cancel button to eject the paper from the back of the product.
3. Carefully remove the jammed paper as shown.
4. After removing the paper, press the paper/cancel button again to clear the error.
5. If you are unable to remove the paper, turn the product off and slowly pull the paper out.

Note: If you are still unable to remove the paper or clear the error, contact Epson for support.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems - Thick Media or CD/DVD
Paper Jam Problems - Sheet Feeder
Paper Jam Problems - Roll Paper
Paper Jam Problems - Thick Media or CD/DVD

If thick media or the CD/DVD tray has jammed inside the product, try these solutions:
1. Cancel the print job from your computer, if necessary.
2. Pull the paper or tray out from the front of the product.

Note: A CD/DVD tray is shown in the illustrations, but the same procedure applies to thick media.

3. After removing the jammed paper or tray, press the paper/cancel button to cancel the error.
4. If the paper/cancel light is still flashing, turn off the product, wait a moment, then turn it back on.

Note: If you are unable to remove the paper or tray, or clear the error, contact Epson for support.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems - Rear Manual Feed Tray
Paper Jam Problems - Sheet Feeder
Paper Jam Problems - Roll Paper

Paper Jam Problems - Roll Paper

If roll paper has jammed inside the product, try these solutions:
1. Cancel the print job from your computer, if necessary.
2. Press the paper/cancel button to eject the paper from the rear of the product.
3. Turn the knobs on the roll paper holders to take up the paper.

![Printer](image)

4. Press the paper/cancel button to cancel the error.

5. If you are unable to remove the paper, turn the printer off and slowly pull the paper out from the rear of the product.

6. If you cannot remove the paper from the rear, cut the paper at the roll paper feeder and pull the paper out from the front.

   **Caution:** Forcibly removing jammed paper from the product could damage the product.

7. If the paper/cancel light is still flashing, turn off the product, wait a moment, then turn it back on.

   **Note:** If you are unable to remove the paper, contact Epson for support.

**Parent topic:** Solving Paper Problems

**Related references**

- Paper Jam Problems - Sheet Feeder
- Paper Jam Problems - Rear Manual Feed Tray
- Paper Jam Problems - Thick Media or CD/DVD

**Paper Ejection Problems**

If you have problems with paper ejecting properly, try these solutions:

- If paper does not eject fully, you may have set the wrong paper size. Cancel printing using the product control panel, then press the paper/cancel button to eject the paper. Remove any paper remaining in the product. Select the correct size when you reprint.
• If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting in your printer software when you reprint.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems - Roll Paper
Paper Jam Problems - Sheet Feeder
Paper Jam Problems - Rear Manual Feed Tray
Paper Jam Problems - Thick Media or CD/DVD

Related topics
Loading Media

Solving Problems Printing from a Computer

Check these sections if you have problems while printing from your computer.

Nothing Prints
Noise Occurs, But Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement
Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:
• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• Make sure the interface specifications match the specifications for the printer and the computer.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
• In Windows, make sure your product is selected as the default printer.
• In Windows, make sure the printer port setting matches the printer connection port.
• In Windows, clear any stalled print jobs from the Windows Spooler:
  • **Windows 10**: Right-click and select **Control Panel > Hardware and Sound > Devices and Printers**. Right-click your product name, select **See what's printing**, and select your product name again if necessary. Right-click the stalled print job, click **Cancel**, and click **Yes**.
  • **Windows 8.x**: Navigate to the **Apps** screen and select **Control Panel > Hardware and Sound > Devices and Printers**. Right-click your product name, select **See what's printing**, and select your product name again if necessary. Right-click the stalled print job, click **Cancel**, and click **Yes**.
  • **Windows 7**: Click and select **Devices and Printers**. Right-click your product name, select **See what’s printing**, and select your product name again, if necessary. Right-click the stalled print job, click **Cancel**, and click **Yes**.

• Make sure the print queue is not paused.
  • In Windows, select **Devices and Printers, Printers**, or **Printers and Faxes** and double-click the printer icon. Select the paused job from the list and deselect **Pause Printing** in the **Printer** menu.
  • In OS X, click the Apple menu, select **System Preferences**, and select **Print & Fax**. Double-click the paused printer and click the **Resume Printing** icon.
  • In OS X, make sure the printer is added to the printer list.

**Parent topic:** Solving Problems Printing from a Computer

**Related tasks**

**Running a Product Check**

**Noise Occurs, But Nothing Prints**

If your product makes a printing noise, but nothing prints, try these solutions:

• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.

• Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

• If you replaced ink cartridges while the product was turned off, the product cannot correctly determine ink levels. Always replace ink cartridges with the product turned on.

**Parent topic:** Solving Problems Printing from a Computer
Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:

1. Do one of the following:
   - **Windows 10**: Right-click \(\text{Control Panel} > \text{Hardware and Sound} > \text{Devices and Printers} \)
   - **Windows 8.x**: Navigate to the **Apps** screen and select **Control Panel > Hardware and Sound > Devices and Printers**.
   - **Windows 7**: Click and select **Devices and Printers**.

2. Right-click your product name, select **Printing Preferences**, and select your product name again if necessary.
3. Click the **Utility** tab.
4. Click the **Monitoring Preferences** button.
5. Click the checkbox for the option that adds the shortcut icon to the taskbar.
6. Click **OK** to close the open program windows.

**Parent topic**: Solving Problems Printing from a Computer

Error After Cartridge Replacement

If you see an error light or error message after you replace an ink cartridge, follow these steps:

1. Make sure the print head is in the ink cartridge replacement position. (The ink cartridge holder should be beneath the cutout in the product case.)

   **Note**: If the print head is not in the ink cartridge replacement position, follow the instructions on replacing an ink cartridge in this manual to move it.

2. Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
3. Complete the ink cartridge installation steps.

**Parent topic**: Solving Problems Printing from a Computer
Printing is Slow

If printing becomes slow, try these solutions:

• Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.
• If you are using Windows 7, close the Devices and Printers window before you print.
• If you are using OS X, make sure you download and install the Epson printer driver.
• Clear space on your hard drive or run a defragmentation utility to free up existing space.
• Close any programs you are not using when you print.
• If your product is connected to a USB hub, connect it directly to your computer instead.
• If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

• Make sure the paper type setting matches the type of paper you loaded.
• Turn on any high speed settings in your product software.
• Select a lower print quality setting.
• Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress, and select the following settings:
  • High Speed Copies
  • Always Spool RAW Datatype
  • Page Rendering Mode
  • Print as Bitmap

Parent topic: Solving Problems Printing from a Computer
Related references
Paper or Media Type Settings - Product Software
Windows System Requirements
OS X System Requirements
Related tasks
Selecting Basic Print Settings - Windows
Solving Page Layout and Content Problems

Check these sections if you have problems with the layout or content of your printed pages.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

- Turn off any mirror or inversion settings in your printing application.
- Turn off the **Mirror Image**, **Flip horizontally**, or **Reverse page orientation** settings in your printer software. (This option has different names, depending on your operating system version.)

**Note**: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X

Too Many Copies Print

Make sure that the **Copies** setting in your printing program or printer software is not set for multiple copies.
Blank Pages Print

If blank pages print unexpectedly, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- If a blank page exists in a document you are printing and you want to skip printing it, select the Skip Blank Page setting in your printer software, if available.
- Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
- Make sure your product is selected as the printer in your printing program.

Incorrect Margins on Printout

If your printed page has incorrect margins, try these solutions:

- Make sure you selected the correct paper size settings in your printing program and printer software.
- Make sure you selected the correct margins for your paper size in your printing program.
- Make sure your paper is positioned correctly for feeding into the printer.

You can use the preview option in your printer software to check your margins before you print.
Border Appears on Borderless Prints

If you see a border on borderless prints, try these solutions:

• Make sure you are printing on a compatible borderless paper type and size.

  **Note:** For custom paper sizes, make sure you select a supported borderless page width.

• **Windows**: Make sure you selected the **Borderless** setting in your printer software.

• **OS X**: Make sure you selected the **Borderless** checkbox or a paper size with a **Borderless** option in your printer software.

• Adjust the **Expansion** setting to adjust the amount of image expansion on the edges of borderless prints.

• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement may not be enough to cover the paper.

• Make sure you have stored the paper correctly. Paper can expand or contract if it is not stored properly. See the instructions that came with your paper for storage instructions.

**Parent topic:** Solving Page Layout and Content Problems

Incorrect Characters Print

If incorrect characters appear in your prints, try these solutions before reprinting:

• Make sure any cables are securely connected at both ends.

• In Windows, delete all jobs from the Windows Spooler. Click **Print Queue** on the Utility tab in the printer settings window, and cancel any stalled print jobs.

• If your product is connected to a USB hub, connect it directly to your computer instead.

• If incorrect characters still appear in your prints, try connecting your product using a different cable.

**Parent topic:** Solving Page Layout and Content Problems
Incorrect Image Size or Position

If your printed image is the wrong size or in the wrong position, try these solutions:

• Make sure you selected the correct paper size and layout settings in your printing program and printer software.
• Make sure your paper is positioned correctly for feeding into the printer.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Slanted Printout

If your printouts are slanted, try these solutions:

• Slide the edge guide against the edge of the paper.
• Select a higher print quality setting in your printer software.
• Turn off any high speed settings in your product software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.

Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Alignment

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows

Related topics
Loading Media
Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

White or Dark Lines in Printout
Blurry or Smeared Printout
Faint Printout or Printout Has Gaps
Grainy Printout
Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head.
• You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper or Media Type Settings - Product Software

Related tasks
Selecting Basic Print Settings - OS X
Selecting Additional Settings - Windows
Selecting Print Layout Options - Windows
Removing and Installing Ink Cartridges
Blurry or Smeared Printout

If your printouts are blurry or smeared, try these solutions:

- Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
- Use a support sheet with special paper, or load special paper one sheet at a time.
- Make sure your paper meets the specifications for your product.
- Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
- Make sure the paper type setting in your product software matches the type of paper you loaded.
- Make sure you loaded the printable side of the paper correctly for your product.
- If you are printing on thick paper or poster board, make sure you select the appropriate settings.
- Remove each sheet from the output tray as it is printed.
- Avoid handling printouts on glossy paper right after printing to allow the ink to set.
- Turn off any high speed settings in your product software.
- If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Align the print head.
- Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Cleaning
Print Head Alignment

Related references
Paper Specifications
Available Epson Papers
Double-sided Printing Options - Windows

Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Settings - Windows
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X
Cleaning the Paper Guide Rollers

Related topics
Loading Media

Faint Printout or Printout Has Gaps

If your printouts are faint or have gaps, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper or Media Type Settings - Product Software

Related tasks
Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Grainy Printout

If your printouts are grainy, try these solutions:

- Make sure you loaded the printable side of the paper correctly for your product.
- Select a higher print quality setting and turn off any high speed settings in your product software.
- Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
- Align the print head.
- You may need to increase the image resolution or print a smaller size; see your software documentation.

**Note:** Images from the Internet may be low resolution and not result in a high quality printout.

- If you enlarged the image in an image-editing program, you need to increase the resolution setting to retain a high image quality. Increase the resolution by the same amount you increased the image size. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the resolution setting to 600 dpi.

**Note:** Higher resolution settings result in larger file sizes, which take longer to process and print. Consider the limitations of your computer system when selecting a resolution, and select the lowest possible resolution that produces acceptable quality to keep file sizes manageable.

**Parent topic:** Solving Print Quality Problems

**Related concepts**
- Print Head Nozzle Check
- Print Head Cleaning
- Print Head Alignment

**Related tasks**
- Selecting Basic Print Settings - OS X
- Selecting Basic Print Settings - Windows
Incorrect Colors

If your printouts have incorrect colors, try these solutions:

• Make sure the paper type setting matches the paper you loaded.
• Make sure the **Black/Grayscale** or **Grayscale** setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• After you print, the colors in your printout need time to set as the ink dries. During this time, the colors may look different than you expect. To speed up drying time, do not stack your printouts on top of each other.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
• Try turning off the **PhotoEnhance** setting in Windows.
• Try adjusting the **Gamma** setting.
• For best results, use genuine Epson ink and paper.
• Make sure that Auto Ink Density Optimization is turned on.

**Parent topic:** Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning

Related references

Available Epson Papers

Related tasks

Selecting Basic Print Settings - OS X
Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Managing Color - OS X
Solving CD/DVD Problems

Check these sections if you have problems printing on a CD/DVD with your product.

Image Not Centered on CD/DVD
Image Does Not Cover Printable Area of Disc
Ink Smears on CD/DVD
Faint Image on CD/DVD

Parent topic: Solving Problems

Image Not Centered on CD/DVD

If your printed image is not centered on the disc, adjust the print position using the Epson Print CD software. See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Image Does Not Cover Printable Area of Disc

If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the edge of the center hole, you may need to adjust the Inner/Outer Diameter Setting in the Epson Print CD software. See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Ink Smears on CD/DVD

If you notice smeared ink on your disc, try these solutions:

• Make sure you are printing on ink jet-printable CDs or DVDs and that the surface of the disc is dry.
• Handle printed discs carefully and let them dry for 24 hours before inserting them in a drive.
• Adjust the print quality using the Epson Print CD software. See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Faint Image on CD/DVD

If your printed image is faint, adjust the print quality using the Epson Print CD software. See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems
Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Printing Software - Windows
Uninstalling Product Software - OS X

Parent topic: Solving Problems

Uninstalling Printing Software - Windows

You can uninstall and then re-install your printer software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:
   - **Windows 10**: Right click and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.
     
     **Note:** If you see a User Account Control window, click Yes or Continue.

     Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

   - **Windows 8.x**: Navigate to the Apps screen and select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.
     
     **Note:** If you see a User Account Control window, click Yes or Continue.

     In the next window, select your product, if necessary, and click OK. Then follow any on-screen instructions.

   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select Epson, select your product, then click EPSON Printer Software Uninstall.
     
     **Note:** If you see a User Account Control window, click Yes or Continue.

     In the next window, select your product, if necessary, and click OK. Then follow any on-screen instructions.
4. Restart your computer, then re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian downloads).
2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
4. Double-click the **Uninstaller** icon.
5. Select the checkbox for each software program you want to uninstall.
6. Click **Uninstall**.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the **Start Here** sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the **Print & Fax**, **Print & Scan**, or **Printers & Scanners** window, select your product name and click the – (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson’s support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.
Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem

Then call:
• U.S.: (562) 276-7272, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday
• Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at epson.com/ink3 (U.S. sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for information on how to return your Epson products for proper disposal.

Windows System Requirements
OS X System Requirements
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:

- Windows 10
- Windows 8.x
- Windows 7
- Windows Vista

Note: Visit Epson’s support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
OS X System Requirements

To use your product and its software, your Mac should use one of these operating systems:

• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.x
• OS X 10.6.8

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.
Cut sheets - plain paper

Capacity

Paper stack up to 0.47 inch (12 mm) thick of these paper sizes:

- A4 (8.3 × 11.7 inches [210 × 297 mm])
- B5 (7.2 × 10.1 inches [182 × 257 mm])
- A5 (5.8 × 8.2 inches [148 × 210 mm])
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])

Paper stack up to 0.20 inch (5 mm) thick on these paper sizes:

- A3 (11.7 × 16.5 inches [297 × 420 mm])
- B4 (13.9 × 9.84 inches [353 × 250 mm])
- Legal (8.5 × 14 inches [216 × 356 mm])

Non-standard sizes between 3.5 inches (89 mm) and 13 inches (329 mm) wide, and between 5 inches (127 mm) and 44 inches (1117.6 mm) long

Thickness

0.003 to 0.01 inch (0.08 to 0.3 mm)

Weight

17 lb (64 g/m²) to 20 lb (90 g/m²)
Cut sheets - thick paper

Size
- Half Letter (5.5 x 8.5 inches [140 x 216 mm])
- A4 (8.3 x 11.7 inches [210 x 297 mm])
- Letter (8.5 x 11 inches [216 x 279 mm])
- Legal (8.5 x 14 inches [216 x 356 mm])
- 11 x 14 inches (279 x 356 mm)
- 11 x 17 inches (279 x 432 mm)
- A3 (11.7 x 16.5 inches [297 x 420 mm])
- 12 x 12 inches (305 x 305 mm)
- 13 x 19 inches (330 x 483 mm)

Fine art media: Non-standard sizes between 8.27 inches (210 mm) and 13 inches (329 mm) wide, and between 11.7 inches (297 mm) and 19 inches (483 mm) long

Poster board: Non-standard sizes between 8 inches (203.2 mm) and 13 inches (329 mm) wide, and between 10 inches (254 mm) and 19 inches (483 mm) long

Capacity
- 1 sheet

Thickness
- Fine art media: 0.012 inch (0.3 mm) to 0.023 inch (0.7 mm)
- Poster board: 0.023 inch (0.7 mm) to 0.051 inch (1.3 mm)

Roll paper

Size
- Width: 13 inches (329 mm)
- Length: 19 inches (483 mm); for guaranteed print quality

Parent topic: Technical Specifications

Printable Area Specifications

Note: When printing borderless, quality may decline in the expanded printable area.
Cut sheets - normal printing

1 Top and side margins: 0.12 inch (3 mm) minimum
2 Top/reduced print quality area: 1.30 inches (33 mm) minimum
3 Bottom/reduced print quality area: 1.42 inches (36 mm) minimum

Note: Poster board margins are 0.79 inch (20 mm).

Cut sheets - borderless printing
1 Top/reduced print quality area: 1.42 inches (36 mm) minimum
2 Bottom/reduced print quality area: 1.54 inches (39 mm) minimum

Note: You cannot print borderless on poster board.

Roll paper - normal printing

1 Side margins: 0.12 inch (3 mm) minimum
2 Top margin: 1.57 inches (40 mm) minimum
3 Bottom margin: 0.55 inch (14 mm) minimum
4 Top margin: 1.97 inches (50 mm) minimum
Roll paper - borderless printing

1

2 Top margin: 1.57 inches (40 mm) minimum
2 Bottom margin: 0.55 inch (14 mm) minimum
3 Top margin: 1.97 inches (50 mm) minimum

Note: For continuous printing on roll paper, there is no margin between printed images (normal and borderless printing).
Ink Cartridge Specifications

**Note:** This product uses only genuine Epson-brand cartridges. Other brands of ink cartridges and ink supplies are not compatible and, even if described as compatible, may not function properly.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink is used for charging, the rest is available for printing. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

**Color**
Photo Black, Cyan, Magenta, Yellow, Red, Matte Black, Orange, and Gloss Optimizer inks

**Cartridge life**
Opened package: 6 months
Unopened package: do not use if the date on the package has expired

---

1 Minimum inner margin: 0.83 inch (21 mm)
2 Maximum outer margin: 4.72 inch (120 mm)

**Parent topic:** [Technical Specifications](#)
Temperature

–4 to 104 °F (–20 to 40 °C)
Within a month at 104 °F (40 °C)
Ink freezes at 5 °F (–15 °C); if left for a long time
Ink thaws and is usable after 3 hours at 77 °F (25 °C) with no condensation

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Dimension Specifications

Height

Stored: 8.6 inches (219 mm)
Printing: 16.5 inches (418 mm)

Width

Stored: 24.5 inches (622 mm)
Printing: 24.5 inches (622 mm)

Depth

Stored: 12.8 inches (324 mm)
Printing: 31.4 inches (797 mm)

Weight

27.1 lb (12.3 kg)
(without ink cartridges or accessories)

Electrical Specifications

Power supply rating

100 to 120 V
220 to 240 V

Input voltage range

100 to 120 V model: 90 to 132 V
220 to 240 V model: 198 to 264 V
**Rated frequency range** 50/60 Hz  
**Input frequency range** 49.5/60.5 Hz  
**Rated current**  
- 100 to 120 V model: 0.6 A  
- 220 to 240 V model: 0.3 A  
**Power consumption**  
- Printing: Approximately 20 W (ISO/IEC24712)  
- (100 to 120 V model) Ready mode: Approximately 4.4 W  
- Sleep mode: Approximately 1.3 W  
- Power off mode: Approximately 0.15 W  
- (200 to 240 V model) Ready mode: Approximately 4.4 W  
- Sleep mode: Approximately 1.3 W  
- Power off mode: Approximately 0.3 W  

**Environmental Specifications**

**Temperature**  
Operating: 50 to 95 °F (10 to 35 °C)  
Storage before unpacking: –4 to 140 °F (–20 to 60 °C)  
Within 120 hours at 140 °F (60 °C); within a month at 104 °F (40 °C)  
Storage after unpacking: –4 to 104 °F (–20 to 40 °C)  
Within a month at 104 °F (40 °C)

**Humidity**  
Operating: 20 to 80% RH  
(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications
Interface Specifications
One High-Speed USB1 port for connection to computer

Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi

Standard  
IEEE 802.11 b/g/n

Security  
WPA-PSK (TKIP/AES); complies with WPA2

WEP (64/128 bit)

Frequency band  
2.4 GHz

Communication mode  
Infrastructure mode

Ad hoc mode (IEEE 802.11n is not supported in this mode)

Ethernet

Ethernet 100BASE-TX/10 Base T standard

Parent topic: Technical Specifications

Safety and Approvals Specifications

United States

Safety: UL60950-1

EMC: FCC part 15 Subpart B class B

Canada

Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:

- Manufacturer: Marvell Semiconductor Inc.
- Type: WLU6117-D69 (WLU6117-D69 [RoHS])

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102 of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities: hands, wrists, feet and ankles).

**Parent topic:** Technical Specifications
Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site for information on how to return your Epson products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks
Copyright Notice

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

General Printer Safety Instructions
Ink Cartridge Safety Instructions
Wireless Connection Safety Instructions

Parent topic: Notices

General Printer Safety Instructions

• Be sure to follow all warnings and instructions marked on the printer.
• Use only the type of power source indicated on the printer’s label.
• Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
• Place the printer near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed.
• If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
• Always turn off the printer using the power button, and wait until the power light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
• Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
• When printing on thick media, leave at least 12 inches (305 mm) of space in back of the printer.
• Leave enough space in front of the printer for the paper to be fully ejected.
• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
• Do not place the printer near a radiator or heating vent or in direct sunlight.
• Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.
• Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
• Do not touch the flat white cable inside the printer.
• Do not move the print head by hand; this may damage the printer.
• Do not spill liquid on the printer.
• Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.
• Except as specifically explained in your documentation, do not attempt to service the printer yourself.
• Unplug the printer and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in the plug, make sure you replace them with fuses of the correct size and rating.
• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the printer from printing.
• Before transporting the printer, make sure that the print head is in the home (far right) position and the ink cartridges are in place.
• When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
• Do not remove or tear the label on the cartridge; this can cause leakage.
• Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to become unusable.
• Do not break the hooks on the side of the cartridge when removing it from the packaging.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges after opening their packages; this can cause them to leak.
• If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the product. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Store ink cartridges in a cool, dark place.
• Make sure to install all ink cartridges. The printer only works when all ink cartridges are properly installed.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
• Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near such devices or inside a medical facility, follow the directions from authorized staff members at the facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Trademarks

EPSON® and SureColor® are registered trademarks, EPSON Exceed Your Vision is a registered logomark, and Epson Connect™ is a trademark of Seiko Epson Corporation.

Epson StoreSM is a service mark of Epson America, Inc.

Epson iPrint™ is a trademark of Seiko Epson Corporation.

Mac and OS X are trademarks of Apple Inc., registered in the U.S. and other countries.
General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution

© 2015 Epson America, Inc.

9/15

CPD-43301

Parent topic: Copyright Notice